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TheBrain 7 Release History 
 
Notes for Version 6 Users: TheBrain 7 is a paid upgrade from PersonalBrain 6. If you purchased a new license of PersonalBrain 6 Pro (not 
including upgrades) after April 30, 2011, your upgrade will be free. For other users, substantial discounts are available. To get your upgrade, go to 
http://www.thebrain.com/store/thebrain and enter your email address. Information added to links using version 7 will not be accessible and may be 
lost if you open your Brain in version 6. 
 
Version 7.0.4.5 
July 27, 2012 

• Mac OS X Improvements and Fixes 
o Retina display support for the plex 
o Fixed: Under Mac OS X Mountain Lion, the application and installer do not run under the default 

security settings 
o Fixed: Events list button on Calendar toolbar is getting cut off on Mac OS X 

• Fixes 
o Fixed: Cut and paste of attachment files results in copy, not cut (original file is not removed) 
o Fixed: The “&apos;” code is not getting un-escaped when notes are synced from server 
o Updated tips to remove references to PB and Core 

 
Version 7.0.4.4 
June 15, 2012 

• Fixed: Links are sometimes drawn from the incorrect gates during the thought creation process 
 
Version 7.0.4.3 
June 14, 2012 

• Fixed: Preferences > Accelerators > Reset on Mac OS X resets to Windows accelerators 
• Fixed: External attachments are skipped if the file length is larger than 50 MB even though they are not 

synced regardless of size 
• Fixed: Can’t dismiss the about screen using “Esc” key 
• Fixed: TheBrain still tries to connect to the sync server when Do Not Connect to a Server is selected (#2375) 
• Fixed: Sometimes modifying a link’s thickness or color does not work 
• Fixed: Link types that have a high thickness are not rendered properly on the link selection menu 
• Fixed: On Windows, an extra shortcut is added to the start menu 
• Sign up button on the login screen opens a web browser instead of using an internal dialog 

 
Version 7.0.4.1 
May 15, 2012 

• Notes Editor 
o More frequent auto-save of notes 
o Fixed: Auto-save prevents the use of the notes editor’s undo/redo functions. 
o Fixed: On auto-save, the text caret position sometimes moves, especially when writing bullet points 

• Support for activation without an Internet connection on the host computer 
o Choose Help > Upgrade to TheBrain Pro Edition, then select “Activate offline.” 

• Fixes 
o Fixed: Drag and drop of URLs from IE and Firefox does not work with Java 7 
o Fixed: Why Go Pro menu entry should not appear if already purchased 

 
Version 7.0.4.0 
May 10, 2012 

• Fixed: Auto-save of notes prevents the local undo within notes from working 
o Auto-save now only happens after 30 seconds of idle time 

• Fixed: Undo/redo operations cause the loss of inherited link characteristics (color, label, thickness) 
 
Version 7.0.3.9 
May 4, 2012 

• Mac OS X 
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o Fixed: Command + D accelerator for Duplicate Thought changed to Command + Shift + D 
o Fixed: Pasting images as wallpaper, attachments, and into notes sometimes does not work 
o Fixed: Pasting HTML into notes sometimes does not work 

• Fixes 
o Fixed: In some cases, pasting an image as an attachment may overwrite an existing image 
o Fixed: Images inside of notes are not downloaded locally and may not be moved into TheBrain’s 

folder 
o Fixed: The context menu for the attachments area does not draw when invoked immediately after a 

prior click 
 
Version 7.0.3.8 
April 30, 2012 

• Mac OS X 
o The default keyboard accelerators for Mac OS are standardized to be more Mac-friendly. In 

particular, function keys are not used, and most accelerators use the Command key instead of the 
Ctrl key. 

§ The most commonly used accelerators that were formerly function keys are now: 
• Create Child: Command + Down Arrow 
• Create Parent: Command + Up Arrow 
• Create Jump: Command + Left Arrow 
• Rename: Command + Enter 
• Focus on Plex: Command + G 
• Focus on Notes: Command + M 
• Search Web: Command + E 

§ If you have altered your accelerators, the new defaults will not be put into place. Delete your 
saved accelerators to force the defaults to load by deleting the file located at 
~/.TheBrain/accelerators.csv. (Open Finder and press Command + Shift + G, then type 
~/.TheBrain, click OK, and delete the file.) 

o Fixed: Copy and paste of files from Finder to TheBrain does not work 
• Fixes 

o WebBrain is now TheBrain Cloud Services 
o Fixed: License agreement says “beta” 
o Fixed: Sometimes when right-clicking the attachments area the add attachment command is 

mistakenly invoked 
 
Version 7.0.3.7 
April 26, 2012 

• Fixed: When rapidly typing in notes, the text caret sometimes gets repositioned to the start of the note 
• Updated German, Dutch and Spanish localizations 
• Smaller installer - removed obsolete image resources 

 
Version 7.0.3.6 
April 26, 2012 

• Faster, easier link editing (#2281) 
o The keyboard accelerator for renaming (F2 by default) works on highlighted and selected links, just 

like it does for thoughts 
• Other changes and enhancements 

o Preferences: New option added to the UI tab for disabling the resizing circle (#2293) 
o The link type context menu is much easier to read and shows what the link will look like with the type 

applied (#2285) 
o The images for local Brains in the list of Brains are drawn using their wallpaper and colors (#2322) 
o On Mac OS X, File > Quit hides the application window immediately 

• Fixes 
o Fixed: Proxy support does not work for secure HTTPS connections 

§ This should fix issues for users with proxies that are not able to upload sync files 
o Fixed: Distant Thought Spacing setting in preferences has little effect (#2274) 
o Fixed: It is possible to open more than one Link window for the same link (#2283) 
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o Fixed: Accelerators for Thought Type and Thought Details work inconsistently on XP vs. Win 7 
(#1883) 

o Fixed: A second right-click on an attachment is interpreted as a left click (#1988) 
o Fixed: When editing a thought’s name via a keyboard accelerator, the Type button should not be 

shown 
o Fixed: Notes editor focus gets lost during typing, focus leaves other controls when a save occurs 
o Fixed: If an attachment is removed changes made to notes in the last few seconds may be lost 

 
Version 7.0.3.4 – First Official Release 
April 23, 2012 

• Fixed: On Windows, when installed in the same folder as PersonalBrain 6, PersonalBrain 6 can still be 
launched but appears in the about box as if it is version 7. 

 
Version 7.0.3.3 – Release Candidate 
April 13, 2012 

• Fixed: If an interrupted sync is found, it should not resume unless the local export sync file can still be found 
• Fixed: Deleted entries are not fully deleted from synced brains 
• Fixed: Upgrade to Pro message for file attachments has a “null” title. 
• Fixed: Final message after sync is complete misleads the viewer to think that sync is still working. 

 
Version 7.0.3.2 – Release Candidate 
March 30, 2012 

• Windows Specific Improvements 
o Updated document-to-text converter, added 64-bit version 
o Status of 64-bit version added to about screen 

• Sync 
o Optimized syncing process 
o Redundant data in the links table is removed when a Brain is opened. This process may take 

anywhere from a few minutes to an hour or more on a large Brain. This is only done once and will 
make syncs much faster. 

o Fixed: Syncs involving events may fail 
• Fixes 

o Fixed: Localized versions of the login dialog don’t display the username/password input boxes 
properly 

o Fixed: Print plex should not invert colors if the background is printed 
o Minor menu resources adjustment 
o Removed “Insert Image” from notes menu – use copy and paste to insert images instead 
o Fixed: Modifying a link’s label removes its color 
o Fixed: Setting link thickness does not work sometimes 

 
Version 7.0.3.0 – Release Candidate 
March 20, 2012 

• Link Types Menu 
o The Link Type context menu has been rebuilt (#2261) 

§ Link type names are rendered using the color assigned to the link type 
§ If there are too many link types to fit on-screen, a scroll bar appears 

• Miscellaneous Enhancements 
o Brain-specific settings in the Preferences > Look & Feel tab are grouped together into a distinct area 
o The list of customizable search providers is scrollable to allow a large number of custom searches 

(#2153) 
o New keyboard accelerator added for Load Expanded View (#738) 

• Windows Specific Improvements 
o Updated native Windows libraries 
o A dedicated installer for the 64-bit version for Windows has been added 
o Fixed: Drag and drop from the 64-bit version of Microsoft Outlook does not always work 

• Fixes 
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o Fixed: Changes to link direction are not updated in the plex when made from a floating link properties 
window (#2220) 

o Fixed: Setting a link’s color to default does not work 
o Fixed: If animation is set to off, the preference is not retained upon restarting 
o Fixed: Sometimes URL icons do not update in the plex 
o Fixed: On logout, the main window does not close if it is in autohide mode 
o Fixed: Hangs when opening certain Brains due to problems calculating future recurring events 
o Fixed: Firefox import accelerator should not be present (#2245) 
o Fixed: Should not have a add jump menu entry on context menu for thought types (#2251) 
o Fixed: Can't rename in open attachments window (#2256, #2012) 
o Fixed: Sort by attachment type/file extension does not work (#2118) 
o Fixed: Accelerator instructions under OS X are incorrect 
o Fixed: Selecting a link and clicking maximize plex renders the button inoperable (#2231) 
o Fixed: Cursor Jumps to the end of the note after hovering over other thoughts (#2143) 
o Fixed: Some brains have errors in the log when trying to update instant search because a prior DB 

update didn't work (#2171) 
o Fixed: Tooltips for link window says "Thought" instead of “Link” (#2214) 
o Fixed: Keyboard shortcut for navigating Back and Forward between Thoughts sometimes skips a 

Thought (#2158) 
o Fixed: Maximize plex removes the Thought tab if a link is selected (#2236) 
o Fixed: Thought Types Window should Auto-Resize according to the amount of Thoughts displayed. 

(#2212) 
o Fixed: Escape key does not cancel the preferences dialog when the Accelerator tab is open (#2259) 
o Fixed: Auto Sync should only auto sync if the user and server have not changed (#2266) 
o Fixed: Calendar move two months when clicking on a day in the beginning of the next month (#2169) 

 
Version 7.0.2.9 – Release Candidate 
March 15, 2012 

• Fixed: Copy and paste of Thoughts sometimes fails to complete (#2255) 
• Fixed: Drag and drop of Thought causes add/open attachment action (#2264) 
• Fixed: OS X cannot delete calendar events using context menu 
• Fixed: Select color button does not work on newly a created brain (#2176) 
• Removed non-applicable accelerators 

 
Version 7.0.2.8 – Release Candidate 
March 2, 2012 

• Login/Logout improvements 
o Add logout/login command to the File menu 
o Preferences > General > User Account indicates when you are not logged in or not connected 
o The “Logout” button in preferences now shows as “Login” when appropriate (#2226 and #2228) 
o The “Brain closing” animation shows during logout/login 

• Calendar and Events 
o Added new repeating event type based on number of occurrences 
o Calendar is much faster at navigating months and other operations 
o Fixed problems with Google Calendar sync not starting 
o Updated Google calendar sync to correctly handle number of occurrences events 
o Fixes for undo/redo not working correctly for events 
o Dismissing of a reminder no longer dismisses the event itself, which will still appear on the calendar 
o Fixed: Reminders show when not yet due and the due date may be off by one day 
o Fixed: On OS X the color of the “More events” link makes it invisible 

• Accelerators 
o Added an accelerator for Attachment > Refresh URL Icon 

• Fixes 
o Fixed: Drag and drop from Apple Mail in OS X Lion does not work 
o Fixed: The Brain management window does not resize properly if the window was resized while a 

Brain was open 
o Fixed: Sync menu should be disabled when not connected 
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o Fixed: The "Searching..." graphic that displays while a search on OS X is being done is not centered 
o Fixed: When adding attachments the UI can become locked up 
o Fixed: On drag and drop of multiple attachments, confirmation of overwrites using "Yes to all" does 

not work 
o Fixed: Thought names starting with very large numbers are not sorted correctly 
o Fixed: Affiliate/Reseller purchase links are not redirected correctly 

 
Version 7.0.2.6 – Release Candidate 
February 24, 2012 

• Easier color selection 
o 70 default colors appear by default instead of just black and white 

• Fixes 
o Fixed: Some Brains cannot be opened due to errors while repairing favicons 

 
Version 7.0.2.5 – Release Candidate 
February 22, 2012 

• Enabled purchase of licenses and services 
• Faster Sync, especially when many links have been modified 
• Fixed: Untyping of Thoughts may not be synced 

 
Version 7.0.2.4 – Beta Release 
February 17, 2012 

• Support for registration of subscriptions and perpetual licenses via WebBrain.com 
• Changes and Improvements 

o Search of attachments and other content on Mac OS X are processed in the background, allowing 
continued use of TheBrain while the search completes 

o The default link width makes links easier to see 
o Updated license agreement 
o Text hints and menus adjusted 

• Fixes 
o Fixed: Can't save a custom date format for notes on Linux because the OK button is off-screen 
o Fixed: Dragging and dropping a file attachment from TheBrain to Outlook does not work 
o Fixed: If a long server address is used, the "Do not connect" link on the login dialog box goes off the 

edge of the window 
o Fixed: Signup using an existing user account name results in the message "An unknown error has 

occurred." 
o Fixed: The brain does not search contacts synched with iCloud on Mac OS X 

 
Version 7.0.2.2 – Beta Release 
February 8, 2012 

• Updated version of notes editor. Fixes image copy and paste issues on Mac OS X. 
• Fixed: Some Brains cannot be opened due to errors while repairing favicons. 
• Fixed: If a Thought has a favicon and a directly assigned Thought icon, the Thought icon is no longer 

displayed when the favicon’s location is repaired. 
 
Version 7.0.2.1 – Beta Release (internal only) 
February 2, 2012 

• Fixed: The about dialog box sometimes incorrectly states, “Pro trial cannot be used with this Brain”. 
• Streamlined purchasing process 

 
Version 7.0.2.0 – Beta Release 
February 1, 2012 

• Fixed: Select link color hint is incorrect 
• Fixed: Link properties window should not allow toolbar to be detached 
• Fixed: Thought icons are syncing even if they are not changed 
• Fixed: Importing from FreeMind does not work correctly 
• Fixed: Favicon files may be stored twice and the favicon may not show next to the Thought 
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• Fixed: The default name for URLs may not be the correct part of the domain name 
 
Version 7.0.1.8 – Beta Release 
January 24, 2012 

• Improved database robustness when adding information 
• When URLs to Twitter accounts are added, they are named using the Twitter account 
• Fixes 

o Fixed: When the Thought properties window shows the name on its own line, the label toolbar has a 
drag bar present. 

o Fixed: Editing an attachment location may incorrectly interpret the location as a local file instead of a 
URL 

o Sync button is disabled when not logged in to a server 
o Fixed: After starting an attachment rename and cancelling, rename cannot be started again 
o Fixed: Instant activate does not return date formatted thoughts in some cases (this also affected other 

multi-word searches) 
o Fixed: The create thought dialog appears at the wrong size if the last create action showed existing 

thoughts and was cancelled 
• Various favicon fixes: 

o Fixed: Refresh URL icon may delete an existing icon if the server cannot be contacted. 
o Fixed: A URL favicon that can’t be loaded results in the appearance of no icon at all on Mac OS 

instead of a generic icon. 
o Fixed: Favicons that are referenced via a base URL cannot be loaded 
o Added utility to check for missing favicons (contact support for details) 

 
Version 7.0.1.7 – Beta Release 
January 15, 2012 

• Updated version of notes editor 
• Proxy settings now support a proxy domain and password 
• Fixes 

o Fixed: Applying a thought type to a thought while it is being created will apply the thought type to the 
source Thought also 

o Fixed: When highlighting or selecting a link the tool label does not change from "Thought" to "Link" 
when in advanced tools layout is enabled 

o Fixed: After assigning a new Brain GUID, Brain will show up twice in the Recently Opened Brain List. 
o Fixed: Assigning new Brain GUID does not complete re-opening of the Brain 
o Fixed: Thought URLs do not link to Thought from notes 
o Fixed: Changes to notes are lost if you touch another thought very briefly 
o Fixed: Click to rename URL does not work if URL is already selected 
o Fixed: In rare cases with very large databases, inserting an attachment may not work due to the note 

not getting associated with the Thought 
• Mac OS Fixes: 

o Fixed: Various dialogue box layout problems 
o Fixed: Open button for Mac Mail, iCal and Address book in search results does not work. 
o Fixed: Lion 10.7.2 search results are not displaying Address Book matches 
o Fixed: Minor install packaging problems 

 
Version 7.0.1.6 – Beta Release 
December 30, 2011 

• Extended beta Pro trial period 
 
Version 7.0.1.5 – Beta Release 
December 21, 2011 

• Fixed: Searches do not word break on apostrophes 
• Fixed: Small grammatical error in resources 
• Fixed: If a sync fails and retries, a permission problem occurs 

 
Version 7.0.1.4 – Beta Release 
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December 14, 2011 
• Fixes 

o Added additional automated login during sync process to avoid potential access control/permission 
errors 

o Better logging of sync errors 
 
When restoring information from the continuous database backup, more information is added to the 
Version 7.0.1.3 – Beta Release 
December 6, 2011 

• Fixes 
o When restoring information from the continuous database backup, more information is added to the 

log if errors occur 
o Fixed: Drag and drop of contacts from Outlook with the drag and drop settings set to “move” removes 

the contacts from Outlook in some cases 
o Fixed: Thought names in URLs are not encoded 
o Fixed: One way link direction changes do not update the display (#2055) 
o Fixed: Toolbar buttons style are not consistent and a drag bar is present 
o Fixed: Thought URLs do not work when name is included in the URL (links from Notes or external 

programs) 
o Fixed: App freezes/hangs when multiple vCards are added as internal files (#2128) 

 
Version 7.0.1.2 – Beta Release 
November 25, 2011 

• Fixes 
o Fixed: Labels on links are searchable 
o Fixed: When brains are restored from BrainZips, the home Thought may not be set properly (#2036) 
o Fixed: Tools show the info for the wrong thought when the mouse is out of the plex window if a 

context menu was active (#1822) 
o Fixed: Once the dictionary has been changed, the background spellcheck can’t be disabled (#1824) 
o Fixed: Notes menu becomes unresponsive when switching spell check dictionary on Mac OS X Lion 

(#1884) 
o Fixed: Plex is not updated after deleting a link (#1924) 
o Fixed: When clicking CTRL+F to bring up the find window for the notes tool, focus is not set to the 

find window (#2054) 
o Fixed: When a Thought URL is pasted, the attachment name is not set to the name of the thought 

(#2062) 
o Fixed: "Brain sorted by" drop down on startup screen is not localized (#2071) 
o Fixed: Downloading an online brain and extracting to a new folder does not make it show in the list of 

local brains (#2078) 
o Fixed: Server settings are not updated completely until you close and restart (#2117) 

 
Version 7.0.1.1 – Beta Release 
November 4, 2011 

• Updated German and Dutch localizations 
• Fixed: 

o Optimized memory management for database queries 
o Fixed: When resizing the plex in transparent mode, the maximized/minimized state is sometimes not 

set properly 
o Fixed: Virtual thoughts do not show the content of folder. 
o Fixed: Editing a tag’s color does not work 

 
Version 7.0.1.0 – Beta Release 
November 2, 2011 

• Maximize Plex Button 
o There is a new button to maximize the plex in the upper right corner 
o The transparency button has been removed – this function is now accessed via the Window menu or 

the background context menu 
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• Miscellaneous Enhancements 
o Updated German localization 
o Forget/Delete button changed to an icon 
o The link direction buttons have been replaced with icons 
o Added support for load balancing of syncs 

• SiteBrain Export 
o Prompts to open the folder containing the export when complete 
o When no wallpaper is present, the gradient background is displayed 
o Fixed: May not work properly when home Thought has been changed 
o Fixed: Should not prompt for overwrite of res folder 

• Fixes 
o Fixed: Can’t paste URLs onto links via the context menu 
o Fixed: Search and indexing of notes and attachments on links 
o Fixed: Links to thoughts and the back/forward buttons don’t clear the selected link 
o Optimized attachment caching to reduce memory usage 

 
Version 7.0.0.8 – Beta Release 
October 21, 2011 

• Miscellaneous Enhancements 
o Non-directed links do not animate on mouse-over 
o A preference for whether double clicking maximizes the plex has been added – this defaults to false 

(a more standard method for maximizing the plex will be added in a future release) 
o Added support for tablet compatible edit boxes in the create thought dialog box 
o Option to not connect to any server at startup 
o Proxy settings can be modified from the login/server settings window 
o The list of brains can be sorted alphabetically 
o Right-clicking on a brain in the list shows the context menu 
o Shows brain closing animation on File > Close Brain 
o Improved conversion of notes to text when copying thoughts as an outline including notes 
o Calendar performance optimized 

• Fixes 
o Fixed: Links from welcome page do not reference specific pages on the web site 
o Fixed: Progress tracker sometimes disappears prior to brain merge being completed 
o Fixed: Thought Type and Tag are not set when creating duplicate Thought (#1977) 
o Fixed: When a link is removed that does not involve the active thought it is not hidden from the 

display 
o Fixed: Problem with drag and drop from IE9 
o Fixed: When a thought type is selected during creation, the type is not applied 
o Fixed: When selecting link thickness, the entries do not highlight as you mouse over them 
o Fixed: Suggests upgrading to Core instead of Pro when adding an attachment 
o Fixed: Text caret moves when renaming a tag thought 
o Fixed: Problem with drag and drop of URLs from Safari on Mac OS 
o Fixed: Shadow and background preferences are not loaded properly 
o Fixed: Mouse wheel scrolling of brains list is slow 
o Fixed: When a selected link is deleted, the plex remains faded and the tools do not get updated 

(#1993, #1999) 
o Fixed: Link types cannot be deleted (#1998) 
o Fixed: Tags appear as parents thoughts in the plex after visiting a Thought Type (#2050) 
o Fixed: The code generated by Export > SiteBrain HTML does not work 
o Fixes for Outlook message extraction into notes 

 
Version 7.0.0.7 – Beta Release 
October 14, 2011 

• Brains Page 
o When no Brain is open, a list of all your local and online Brains is shown. This gives you a single 

place to find all your Brains. 
§ Brains are listed according to how recently they have been accessed (a future update will 

allow sorting this list alphabetically also) 
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§ Brains that are only available online are shown last 
§ The list of local Brains is created by showing the Brains found in folders known to have brains 

in them. If a Brain is not shown in the list, then you can open it using File > Open Brain and 
the next time the list is shown it will be updated to include brains from that location. 

o From the Brains page, Brains can be: 
§ Renamed 
§ Moved 
§ Deleted 
§ Opened, both locally and online 
§ Downloaded from the server 
§ Uploaded to the server 

• Miscellaneous Enhancements 
o Instant search has been further optimized 
o Preferences look and feel fine tuned 
o Link labels are drawn using the default text colors instead of the link color 

• Fixes 
o Fixed: Exception on start under Mac OS 
o Fixed: Single clicks on the Calendar register as two clicks in some cases 
o Fixed: Pasting of Web links and other content does not work when pasting to a link 
o Fixed: There are some layout issues with the startup and preferences dialogs 
o Fixed: The proxy settings are not used for HTTPS connections and at initial startup 
o Fixed: Some menus are disabled after logging out 
o Fixed: Some preferences are not saved 
o Fixed: Can’t login by pressing the Enter key, requiring the mouse to click the login button 
o Fixed: Login information is not saved when the server cannot be reached 
o Fixed: Some messages say “Free” instead of “Pro” and vice-versa 

 
Version 7.0.0.6 – First Public Beta Release 
October 1, 2011 

• PersonalBrain is now TheBrain 
o The client software is now simply known as TheBrain software. 
o There is no longer a Core edition. Instead, there is the Free edition and the Pro edition. 

• Redesigned Display 
o The new layout engine featuring curved link lines makes it easier understand the relationships 

between Thoughts 
o Links are easier to highlight and click 
o Improved expanded view layout 

• Performance 
o Animation and display optimized for speed 
o Database storage optimized for speed 

• Enhanced Links 
o Selecting Links 

§ Click a link to select it. The link is displayed prominently as unrelated Thoughts and links fade 
into the background. 

§ Clicking on a selected link shows the context menu for the link. You can also right-click on a 
link to show context menu without selecting it. 

o Link Notes and Attachments 
§ Just like Thoughts, links can now have notes and attachments 
§ When a link is highlighted or selected, the Notes and Link tabs show the notes, properties, 

and attachments associated with the link. 
§ Floating windows can also be opened for link properties and attachments and notes 

o Link Directionality 
§ Links are by default non-directed  but can set to be directed or one-way 
§ Non-directed links do not show any indication of either Thought being the source of the link 
§ Directed links show arrows on them and animate when touched, showing movement from the 

source Thought toward the other Thought 
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• Directed links are particularly useful when using link labels. For example, with the link 
label “inspired” looking at the link direction shows which thought was the source of 
inspiration. 

• This is also very useful when representing flows between items, such as financial 
relationships. 

§ One-way links 
• One-way links appear when the source of the link is active and do not appear when 

the target thought is active unless the source thought was already visible. 
• One-way links are indicated by an arrow with a rectangle at one end. 
• One-way links are useful in cases where Thought A is relevant when Thought B is 

active but Thought B is not relevant when Thought A is active. For example, you may 
want to see what company a person worked for when the person is the active 
Thought. However, for a large company with thousands of employees, you may not 
want to see all of the employees when that company is the active Thought. Creating 
a “works for” link type and making it one-way enables this. 

§ Link direction can be set on links as well as link types. Direction set on a link type is inherited 
by instances of the type and can be overridden by the instance 

§ Click the arrow icon on the link tab to switch a link between non-directed, directed, and 
directed in the reverse. 

§ Use the One-way checkbox to make a link one-way. This option must be unchecked in order 
to make a link non-directed.  

o The Link Tool 
§ The Thought tool now doubles as the Link tool and changes depending on what is selected or 

highlighted. 
• When a link is the focus, the inapplicable controls for icon, name, and privacy do not 

appear. New controls to change link direction, toggle unidirectional state and set link 
thickness appear. 

o Other link enhancements 
§ Link labels are always displayed, even when not highlighted 
§ Label, color and thickness can now be set independently of type 

• If set to default values, these properties are inherited from the type. If set, they 
override the values of the type 

§ Links with a thickness of up to 15 pixels wide are now supported 
§ Link types can be created from the link context menu 
§ The default thickness of links is configurable in Preferences > Look & Feel 

o Copy and pasting of Thoughts also copies the links between them along with any notes, attachments, 
and other properties associated with the links. 

o Synchronization updates links and their data automatically between brains. Advanced link properties, 
including direction, one-way links, notes, and attachments are not available via the web client. 

• Startup 
o Upon startup, you must login to your WebBrain.com account. This enables integration with your 

online Brains and subscription information. The startup dialog also features a sign up capability. 
• Preferences 

o Re-organized so often used items are easier to find 
o Added more preferences for links 

§ Straight or curved links 
§ Show link labels only on mouse-over 
§ Glowing links 

o Proxy settings can now be configured in the Preferences > Advanced area. 
• Custom Reports 

o Added the ability to report on Thoughts that use link types in custom reports 
• Instant Activate 

o Types are prioritized in results above normal thoughts, just like tags 
o Tags can be found using multiple word queries, not just the first word 

• Calendar 
o Events that span multiple days are drawn in the calendar as such, making them much easier to see 

and understand 
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o Calendar events and popups can now be edited with the keyboard 
• Linux Drag and Drop 

o Support for drag and drop of files and URLs in Linux 
• Miscellaneous Enhancements 

o Added the ability to delete links and thoughts via the Thought/Link window 
o Improved sync progress feedback 
o Brain metadata including the name and home thought are now synced 
o Up to 100 themes can be saved 
o Ability to undo and redo various commands in a single step: paste image and URL image, delete 

multiple thoughts, delete multiple files 
o Long names in imported FreeMind files are put into notes 
o Added larger maximum file sizes for indexing 

• Fixes 
o Fixed: The link properties window style should match other property windows 
o Fixed: If a virtual thought attached to a forgotten thought is activated, forgotten thoughts should be 

turned on 
o Fixed: Problem when adding a repeating weekly event and no days are selected 
o Fixed: Word Outline Import removes line breaks in body text 
o Fixed: Sort menu does not highlight on mouse over 
o Fixed: For Presentation mode on Mac, dialog boxes cause the display to exit presentation mode 
o Fixed: If Thought GUID is not a native GUID (as when created via an import), Thought URLs cannot 

be opened 
o Fixed: Smart quotes are not recognized by the insert link to thought operation in notes 
o Fixed: URL Links to Thoughts which contain Russian characters do not work in the simple HTML 

export  
o Fixed: URL links to Thoughts from Thought tool do not work in SiteBrain export  
o Fixed: Exporting a brain to a SiteBrain that contains a hash symbol in the name causes error when 

viewed in IE 8  
o Fixed: Problem related to import of attachments from a Mind Manager file 
o Fixed: Export to folders can fail in certain cases  
o Fixed: Redraw issue for thought types dialog 
o Fixed: Switching themes causes pins to be lost in certain cases 
o Fixed: Retrieving the list of inheriting thoughts can be slow if there are cyclic relationships 
o Fixed: Wallpaper in a brain with foreign characters in the name causes preference not to save 
o Fixed: Sync to Google calendar with repeating weekly events without a day set causes problems 
o Fixed: First thought in a brain does not show in instant activate when first created 
o Fixed: Virtual thought pins do not display after a brain is closed and opened 
o Fixed: Drag and drop of a file to the plex while a tag thought is active causes an error 
o Fixed: Changes to notes are not included if made immediately prior to BrainZip creation 
o Fixed: In rare instances, problems can occur with data migration from version 5.5. 
o Fixed: Thoughts named based on YouTube page titles may contain strange control characters 
o Fixed: Undoing delete tag causes an error to occur 
o Fixed: Search automatically for a moved attachment will not find a moved folder 
o Fixed: A virtual thought named with a similar name to another such as “4.6.1” and “4.6” will not 

appear 
o Fixed: Should not show progress bar when moving a single file into brain 
o Fixed: Error messages from the WebBrain server on failed login attempts are not displayed 
o Fixed: If Outlook is not running and an item is opened that is not in the local store, an error message 

is displayed 
o Fixed: Some keys, such as “Page Up” cannot be used as the Hot Key 
o Fixed: Copying an animated .gif from IE as a thought icon causes problems with deleting that icon 
o The system for inheriting properties from link types has been rewritten from scratch 
o Fixed: Reminders can sometimes show up before due 
o Fixed: Weekly calendar events from Google sometimes do not sync correctly 
o Fixed: Copy/paste, drag and drop operations on files/folders ask for confirmation of overwrites 

multiple times 
o Fixed: In certain cases, checkboxes to not work (when next to certain characters) 
o Fixed: After sync, tag counts do not get updated 
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o Fixed: Importing thoughts with GUIDs that have been deleted fails because duplicate GUIDs can't be 
created 

o Fixed: Problem with accelerators in java 7 
o Fixed: Problem if Cancel is pressed when selecting a file to import 
o Fixed: When dragging and dropping a URL from IE9, hold down the Shift key to get the full URL (this 

was not possible before) 
o Updated version of notes editor 

• Mac OS X Fixes 
o Fixed: Various problems with menus in the notes editor 
o Fixed: Problem running when multiple screens are in use with mirroring enabled 
o Fixed: Reminder dialog causes the non-transparent main window to be displayed when in 

transparency mode. 
o Fixed: Problems searching for emails on Lion 

 


